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Product Proficiency Exam Bulletin

Adobe® Photoshop CS5
Exam # 9A0-150

ACE Certification Checklist

The checklist below will help guide you through the process of obtaining ACE certification.

• Review this bulletin to become familiar with the topic areas and objectives of the exam.

• Identify the topic areas and objectives you need to study.

• Determine which study materials you need to improve your skills. 

• For a list of recommended study materials, visit:
http://www.adobe.com/misc/training.html

• Study for the exam.

• Contact Pearson VUE to register for an exam: http://www.pearsonvue.com/adobe

• When registering for the exam, refer to the exam number located at the top of this bulletin.

• Take the exam.Your score is electronically reported to Adobe and will also be displayed 
when you complete your exam.

• Upon passing the exam, your certificate will be sent to you via email. Please ensure that 
you have provided an accurate email address.

• You can update your certification profile by going to: http://www.adobe.com/support/
certification/community.html. You will need the information provided on your score report 
to create a user account.
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Exam Structure

The following lists the topic areas and percentage of questions delivered in each topic area:

Number of Questions and Passing Score

• 64 questions

• 74% minimum required to pass

Test Content: Topic Areas and Objectives

Following is a detailed outline of the information covered on the exam.

1. Working with selections

• Given a scenario, create a selection using an appropriate tool or method.

• Save and load selections.

• Move and transform selections.

• Given a scenario, use Refine Edge controls to capture detail in soft and hard selection 
edges (options include decontaminating edge color).

2. Working with Layers

• Create and manage layers in the Layers panel (includes creating, reordering, selecting, 
controlling visibility of, duplicating, locking, clipping, grouping, deleting layers).

• Given a scenario, use layer Blend modes to achieve a desired effect.

• Given a scenario, use Opacity and Fill controls in the Layers panel to achieve a desired 
effect (options include ability to vary Opacity/Fill of multiple layers)

Topic Area % of
Exam

# of
Questions

Working with selections 6% 4
Working with Layers 16% 10
Using Masks and Channels 6% 4
Working with Type and Vector tools 8% 5
Adjusting and processing photographs 16% 10
Retouching and Manipulating images 5% 3
Working in Adobe Camera Raw 6 9% 6
Painting and filtering an image 8% 5
Working in Photoshop 18% 12
Outputting for Print and Web 8% 5
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• Given a scenario, successfully work with Smart Object layers (options include creating, 
transforming, editing, and duplicating Smart Object layer; creating multiple Smart 
Object layers from a Camera Raw file; and importing and editing vector objects as Smart 
Objects).

• Given a scenario, combine images to make a collage (options include dragging and 
dropping a closed file into an open document, dragging layers from one open image to 
another, using Shift to register layers, Paste in Place and Paste Into commands).

• Apply, customize, and set default values for Layer Styles.

• Use Layer Comps to save different designs within a single image.

3. Using Masks and Channels

• Given a scenario, successfully create and edit layer masks (includes using the Masks 
panel, painting on a mask, converting a selection to a mask).

• Explain the benefits of using layer masks and vector masks.

• Explain the differences between color channels and alpha channels.

• Describe how to create a spot color channel suitable for prepress.

4. Working with Type and Vector tools

• Create and edit type layers.

• Describe the difference between pixel-based and vector-based images.

• Create graphic shapes using the Shape tools.

• Use the Pen tools to create or edit a vector path.

• Understand how to manage one or more paths in the Paths panel.

5. Adjusting and processing photographs

• Given a scenario, correct the color and tone in a photograph using the appropriate 
adjustment layers and commands (options include Levels, Curves, Hue/Saturation, 
Vibrance, Brightness/Contrast, Shadows/Highlights, and Auto Color).

• Explain the advantages of using Adjustment layers.

• Use the Adjustments panel to create and manage one or more adjustment layers.

• Successfully perform on-image adjustments with Curves, Hue/Saturation, and Black and 
White adjustment layers.

• Convert a color image to black and white with the most control.

• Create a panorama from multiple photographs.

• Enhance the dynamic range of an image with Merge to HDR Pro.

• Correct lens-related errors with the Lens Correction filter (options include chromatic 
aberration, distortion, and vignetting).



Page 4 of 8

• Given a scenario, sharpen a photograph correctly (options include Unsharp Mask, Smart 
Sharpen, and the Sharpen tool)

6. Retouching and Manipulating images

• Given a scenario, use the appropriate retouching method (options include Content Aware 
Fill, Spot Healing Brush with Content Aware option, Healing Brush, Patch tool, Clone 
tool, and the Clone Source panel).

• Given a scenario, correctly use Puppet Warp to deform an object (options include 
repositioning limbs, retouching portraits, changing stacking order of objects, and 
correcting photographic distortion).

7. Working in Adobe Camera Raw 6

• Explain the purpose of the primary Camera Raw adjustment settings.

• Given a scenario, successfully apply a local correction in Camera Raw (options include 
Adjustment brush, Gradient filter, and the Spot Removal brush).

• Use Camera Raw controls to reduce luminance noise and color noise.

• Explain the Camera Raw to Photoshop workflow.

• Given an option, open and manipulate a JPEG or TIFF in Camera Raw.

• Describe the Camera Raw to JPEG workflow.

8. Painting and filtering an image

• Given a scenario, use the Mixer Brush and its options properly.

• Given a scenario, adjust Bristle Tip brush settings appropriately.

• Given a scenario, choose and use the proper method of choosing a color (options include 
HUD Color Picker, Eyedropper tool with color ring, Swatches panel, Color panel, and 
the Color Picker).

• Understand how and why to use Smart Filters.

• Create and use gradients and patterns.

9. Working in Photoshop

• Use Mini-Bridge to view, manage, and open images inside Photoshop.

• Describe how to arrange panels and manage workspaces (options include arranging and 
docking panels, customizing shortcuts, saving custom workspaces, using the workspace 
switcher).

• Work with tabbed documents and controls in the Application bar (options include tabbed 
documents, arrange documents menu, screen modes, canvas rotation, Application Frame, 
and n-up).

• Given a scenario, choose an appropriate method to zoom and pan in the document 
window (options include the new scrubby zoom feature).
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• Given a scenario, create a new file (options include size, color mode, and resolution)

• Given a scenario, properly resize an image (options include Image Size dialog box, 
resampling controls, Canvas Size dialog box, Transform options, Crop tool, and Content 
Aware Scale).

• Given a scenario, know how to crop and straighten an image (include grid for rule-of-
thirds, perspective cropping, and the Ruler tool Straighten option.)

• Successfully add copyright and other metadata to images in Photoshop and Bridge.

• Understand common file formats and the pros and cons of saving an image in those 
formats.

• Describe how to switch between 32 bit and 64 bit mode on Windows and Mac, and 
understand the advantages of each mode.

• Understand the process of color management in Photoshop (options include Color 
Settings, converting to and assigning color profiles, embedding a color profile in the Save 
dialog box, and the color management settings in Print dialog box)

10. Outputting for Print and Web

• Given a scenario, configure settings in the Print dialog box for output.

• Given a scenario, soft proof an image in Photoshop.

• Create a Web Gallery using Adobe Bridge.

• Given a scenario, use the controls in the Save for Web and Devices window to optimize 
photographs and graphics for the web.

• Correctly slice a web layout into multiple files using layer-based slicing and the Slice 
tools.

Practice Exam

Try out these practice questions to get a feel for the types of questions on the ACE exam. Please 
note that your performance here does not indicate how you will do on the actual exam. To fully 
prepare for the exam, closely review the topic areas and objectives in this Exam Bulletin.

1.1 Given a scenario, use Refine Edge/Mask to capture increased detail in both soft and 
hard edges

You are making a selection around the profile of a model whose hair is blowing in the wind. 
Which feature should you use to create a selection that captures both the strands of hair and 
the smooth edge of skin on the model?

A. Refine Edge dialog box

B. Magic Wand tool
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C. Magnetic Lasso tool

D. Soft Light blending mode

Correct answer: A

2.2 Explain the causes of and solutions to ghosting in merged HDR photos

What is the most likely cause of ghosting in an HDR photograph?

A. Movement of items in the scene during shooting

B. Choosing an improper white balance setting in the camera

C. Shooting raw files, rather than jpegs

D. Shooting with a high ISO setting

Correct answer: A

3.1 Given a scenario, successfully create and edit layer masks (includes using the Masks 
panel, painting on a mask, converting a selection to a mask).

Which method allows you to load a selection from a layer mask's boundaries? 

A. Ctrl-click (Windows) / Command-click (Mac OS) the layer mask thumbnail in the Layers 
panel. 

B. Alt-click (Windows) / Option-click (Mac OS) the layer mask thumbnail in the Layers 
panel. 

C. Target the layer mask in the Layers panel, and then choose Layer > Layer Mask > Apply.

D. Select the layer mask in the Layers panel, and then choose Select > Refine Mask. 

Correct Answer: A

4.1 Given a Raw image file, reduce luminance and color noise

You're processing a Raw photograph that has many small dots of color noise in the shadow 
areas. Which settings in the Detail tab of Adobe Camera Raw should you change to reduce the 
color noise? 

A. Increase the Noise Reduction Color slider and slightly increase the Noise Reduction Color 
Detail slider.

B. Minimize the Noise Reduction Color slider and maximize the Color Detail Luminance 
Detail slider.

C. Increase the Sharpening Radius and Amount sliders.

D. Decrease the Noise Reduction Luminance and Luminance Contrast sliders.
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Correct answer: A

5.2 Given a scenario, select and use the appropriate Mixer Brush options

You are using the Mixer Brush tool to paint on a photograph. You are working on a layer 
above the Background layer, and you have Sample All Layers enabled in the Options bar. You 
want to sample multiple colors from the photograph and load the colors into the paint reservoir 
of the brush. What should you do?

A. Hold the Option key (Mac OS) or the Alt key (Windows) as you click on the photograph 
in the document window.

B. Hold the Shift key as you click on the photograph in the document window.

C. Enable the automatic Load option in the Mixer Brush tool Options bar 

D. Enable the automatic Clean option in the Mixer Brush tool Options bar 

Correct answer: A

6.2 Given a scenario, correctly use Puppet Warp to deform an object (options include 
repositioning limbs, retouching portraits, changing stacking order of objects, and 
correcting photographic distortion).

You are using Puppet Warp to fix some distortion in a single-layered photograph. You want to 
use Puppet Warp non destructively, so you can make multiple changes over time without 
increased image degradation. What should you do?

A. A.Convert the layer into a Smart Object; then apply Puppet Warp.

B. B.Convert the Background into a regular layer; then apply Puppet Warp.

C. C.Apply Puppet Warp to a duplicate layer; then merge the two layers together.

D. D.Place some pins using Puppet Warp; then Shift-drag one or more of the pins.

Correct answer: A

7.7 Use the enhancements to adjust image features

In which situation will you realize the largest increase in speed by using Photoshop as a 64-bit 
application when compared to running Photoshop as a 32-bit application?

A. When you're working with very large files

B. When you're working with RGB or Lab mode files

C. When you're applying Filter Gallery filters.

D. When you're working in the Save for Web dialog box
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Correct answer: A

8.3 Given a scenario, explain how to choose a foreground color (options include HUD 
Color Picker, Eyedropper tool with color ring, Swatches panel, Color panel, and the 
Color Picker).

You have the Brush tool selected and an image open. You want to load a new foreground color 
with which you can paint. What should you do?

A. Hold down Option (Mac OS) or Alt (Windows) and click on a pixel in your image.

B. Choose Load Swatches from the Swatches panel menu.

C. Right-click (or Control-click with a one-button mouse) on a pixel in your image.

D. Switch to the Color Sampler tool, click, then press B to return to the Brush tool.

Correct answer: A

9.7 Given a scenario, know how to crop and straighten an image (include grid for rule-
of-thirds, perspective cropping, and the Ruler tool Straighten option.)

You have two photographs open. You want to crop the larger photograph so that the result is 
the same size as the smaller one. Which is the most efficient way to do that?

A. Make the smaller photograph active. Select the Crop tool, and click the Front Image but-
ton. Switch to the larger photograph, drag out a crop boundary, and click OK.

B. Make the smaller photograph active. Choose Select All. Switch to the larger photograph, 
drag out a crop boundary, and click OK. 

C. Select the Crop tool, and drag out a crop boundary in the smaller photograph. Drag the 
crop rectangle onto the larger photograph, and click Return (Mac OS) or Enter (Win-
dows).

D. Make the larger photograph active. Choose Image > Image Size. Choose the name of the 
smaller image from the Window menu, then click OK.

Correct Answer: A


